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About This Product

Theory of Performance

The ViewAll Vet Imaging Software application is designed to acquire, display, organize, store and output digital 
radiographic images for veterinary diagnostics.  The software is a common interface for all AFP Imaging’s digital 
veterinary X-Ray imaging equipment. In order to capture radiographic and other images, ViewAll Vet must have an active 
patient selected. Once the digital radiographic image and/or images are acquired, ViewAll Vet will store the images 
in the patient database as DICOM files. After an image has been acquired it is automatically saved and displayed on a 
computer monitor.  A suite of image processing tools are available for the operator to enhance the displayed image for 
their particular diagnostic analysis. Such enhancement tools include, but are not limited to: Magnify, Gamma, Window 
and Level, Linear Stretch, and Equalize. Each anatomical template used to acquire digital X-ray images has a layout for 
viewing the images together. The Study View tab allows the user to view the selected patient’s images in these pre-
defined layouts.  ViewAll Vet implements specific DICOM operations. Please refer to the ViewAll Vet DICOM Conformance 
Statement for details.

Product Registration

ViewAll Vet requires a license to use beyond the 30 day full version trail period. To register your ViewAll Vet Software 
Via the internet, go to Help > License Registration, or call technical support and register over the phone.

Contact Information

Technical Support:	 (914) 592-6100
Fax:			   (914) 592-7613
E-mail:			   support@afpimaging.com
Web:			   www.afpimaging.com
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ViewAll Vet Overview

ViewAll Vet has been designed using a Tabbed interface. 
Each tab is designated a specific set of tasks. 

The Patient Tab is designed for selecting the active patient, selecting the active study, adding new owner/patients, 
editing existing owner/patient information and conducting various searches under a wide variety of criteria.

The Acquire Tab is designed for the sole purpose of acquiring images. The user is prompted to select an acquisition 
template that is appropriate for the current patient. From the template, the user can select the anatomical region and 
view or tooth for the X-rays being captured. This information will then be automatically added to each image in their 
corresponding DICOM tags and in the patient database. 

The Diagnosis View Tab is designed to allow the user to view and edit one image at a time. All of the image 
enhancement tools and filters are located in this tab, as well as annotation tools and demographic data overlays.

The Study View Tab is designed to view images from a study in a predefined layout. The user can also add new layouts 
to the existing study and drag and drop images into the different positions.

The Light Box Tab is designed to view multiple images from different patients and different studies next to each other. 
The display automatically arranges the images based on the number and orientation of the selected images. Basic 
tools are provided to zoom in and out and adjust brightness, contrast and gamma. 
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ViewAll Vet Log-In Feature

ViewAll Vet has the optional use of login accounts. It is recommended that each user create an account name and 
password.  At start-up ViewAll Vet displays the Login window shown below. The login system can be set up to require 
user names and passwords or user names without passwords.

To add user accounts and/or edit user accounts, go to Edit  > User Accounts
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To make changes to the User Login Preferences, go to Tools < Options, in the General settings area.
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Detailed Tab Descriptions

Patient Tab
The Patient Tab is the entry point into the software. In this tab the user can create new patients, find existing patients 
and edit patient information. Click on “Results of Last Search” tab and then “Show All Patients” in the right-hand stack.

Stacks and Work Areas
Each tab area has two main working areas. On the right-hand side of the area is what is called the “stack”. The stack 
may be collapsed and expanded as needed and has various subjects that are applicable to whatever tab is selected. 
For example, in the Patient tab, the stack on the right has search criteria for sorting through patients and owners, ID 
numbers, etc. One of the newer features of this stack is the ability to display DICOM Worklist Patients.

The area on the left is the working area. Both the working area and the stack area have their own smaller tabs. The 
Diagnosis View tab, in particular, has a number of smaller tabs in the stack area that pertain to tools, demographics, 
annotations, etc.
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Create a New Patient

To create a new Patient, click the New Patient button.

The following window will open where the user can enter all the patient and owner information. 

Create a Stat Patient

To create an Emergency patient, click the STAT Patient button.

This will create a patient with the Date and Time as the patient’s name. Use this patient to capture images right away 
and then update the patient information afterwards. Quickly find the STAT patients by selecting the “STAT Patients 
Only” quick search button from the right-hand stack area.
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Patient/Image Searching

The searching tools are divided into two categories: quick search buttons and detailed searching.
The following quick searches are available:
•	 Flagged Patients – displays a list of patients that have been flagged (this flag can be set in the “Edit current 	 	
	 patient…” window).
•	 Yesterday/Today Patients – displays a list of patients with images captured within the past 48 hours.
•	 Patients Over Last Month - displays a list of patients with images captured within the past 30 days.
•	 Stat Patients Only – displays a list of the STAT/emergency patients that have been created.
•	 Show all Patients – displays all patients alphabetically.
•	 Deleted Patients Only – displays a list of patients that have been deleted.
•	 DICOM Worklist Patients - displays a list of patients from the Worklist present on DICOM server.

The user can search for the Patient Name, Owner Name and/or Patient ID by entering the text in the correct text box 
and clicking the “Find” button. Only patients with the matching criteria will be displayed. The user can also choose 
dates that images were captured on or in between, again clicking the “Find” button to apply the search. Only patients 
with images captured on the selected date or in the selected date range will be displayed. 

Use the Provider and Breed searches to only display patients belonging to the selected provider or of the selected 
breed.

Once a search is complete, the list of patients will be displayed. Click on the Plus (+) sign next the patient’s name to see 
that patients list of studies. 
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Selecting the Active Patient and Study

Start in the “Results of Last Search” Tab.
To select the Active Patient, the user must Double-Click on the patient’s name.
To select the Active Study, the user must Double-Click on the study name.
Use the Clear button to deselect the Active patient and study.

Double-click on a Patient to view and/or edit that patient’s information, as well as set that patient as the Active Patient. 
The “Owner/Patient Information” Tab will then open.

Click once on a study and the Thumbnail images will be displayed in the Filmstrip. 
Double-click on the study to open the “Owner/Patient Information” Tab, to see the Thumbnail images and to set that 
study as the Active Study.

The active patient and/or study will be displayed in the status box.
Click this icon to unselect the patient/study:             This shows the patient and study selected.
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Patient selected, no Study selected:

No Patient or Study selected:

Patient Tab Toolbar

     Add Patient Button
	   Add Stat Patient Button
		         Deselect Patient Button
						      Status Box

Exports a DICOM directory and burns it to a CD  or DVD

DICOM send (must have an account or server set-up for this)

Exports a DICOM directory

Collapses the “Stack” Expands the “Stack”
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Acquire Tab

The acquire tab is where the user can acquire images for the active patient. If no active patient is selected, the acquire 
module will prompt the user to select a patient, or create a STAT patient to continue.

In order to acquire images, there must be a selected hardware device. If a device has already been selected, it will 
be displayed in the title bar of the ViewAll Vet window. If no device has been selected, the title bar will display “View 
Station”. See below for more details on selecting a device.

Capturing an Image

The user must complete three steps in order to capture a digital X-Ray image. The following steps will demonstrate 
using an EVA sensor.

After opening the ViewAll Vet software and logging-in, the user must:
1.	 Select the active patient.
2.	 Select the correct Hardware.
3.	 Select an Acquisition Template.
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The first step is selecting a patient. In the Patient tab, find the desired patient and Double-Click on the patient’s name. 
This patient is now set as the Active Patient. (See page 12 for detailed description of setting the active patient).

The second step is to select the hardware device that you will be using. This step is not often required because the 
software remembers the last device that was selected. 
Go to Drivers <  Driver Manager, and the following window will open. Select the desired hardware, for example, the 
Eva sensor, and click Done. The active hardware will be displayed in the title bar of ViewAll Vet.

The third step is to select an acquisition template. The user can choose an Acquisition Template from the drop down 
list. Once a template has been selected, the user can select a region and a view (if multiple views are available for the 
particular region). The drop down list of templates changes based on the species on the active patient. If a Cat patient 
is active, only the cat templates are shown. If a STAT patient is active, all the templates will be shown.

Important Note: When a template is displayed, the first region/view to be taken will have the numeral “1” shown on 
it. This will be the first of a predetermined order of exposures that are determined in the “Layout Editor” (which will be 
discussed later). This order may be altered immediately prior to taking exposures by clicking on the regions/
views desired. Then, upon entering the Sequential or Single Capture mode, the X-rays will be taken in that new 
order.

To capture an image, the user must select a capture mode: Single Capture or Sequence Capture. This process has been 
somewhat automated by going into the acquire mode automatically upon entering the Acquire Tab. Whether the 
Single Capture or Sequence Capture mode starts up is determined by setting this previously in the “Tools < Options 
< Acquire Tab Options” window. If one wants to change this on the fly, simply click on the “Stop Acquisition” button 
in the Acquire Tab and reselect the mode desired. Once one of these buttons is pressed, the software will tell the 
hardware to be ready to acquire an image, and the Acquire Status (traffic light signal) will change to Yellow. When the 
hardware is ready the status will change to Green. Now the user can fire the X-Ray unit.

Note	 Only the hardware that is available on that system will be 
	 displayed in this window.
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Once the image data is received it is displayed and a thumbnail of the image is added to the filmstrip.

Each acquire session will be saved as a new study for the Active Patient. The exception to this rule is if the Active 
Patient has a study that is not more that 36 hours old. In this case, the user will be asked, upon entering the Acquire 
Tab, to append to the last study or start a new one.

Acquire Tab Toolbar

Add Stat Patient Button

Start Single Acquisition Mode 
Button

Start Continuous Acquisition Mode 
Button

Stop Acquisition Button

Retake Exposure Button

Skip Ahead to Next Exposure Button

Acquire Status “StopLight” ON/OFF Button

Status Windows
Expand/Collapse
   Stack Buttons

Re-Set Exposure Sequence Button

Acquire Tab “Stack”
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Diagnosis View Tab

At any time the user can double-click on an image or thumbnail and it will 
automatically open in the Diagnosis View Tab. 

Above the image are several tool buttons. To the right of the image is the stack. The stack contains all the image 
manipulation tools, annotation tools and demographic information overlay tools. The stack area can be minimized to 
allow the image to have maximum viewing area. Simply click on the collapse/expand buttons.

To apply an enhancement tool from the Toolbox, click on the add button                 and select the tool from the list that 

appears. This will add the tool to the Stack. The stack performs each tool in order, from top to bottom. Full descriptions 
of each tool can be found in the Enhancement Tool Descriptions section of this document.
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Drop-down list of tools that appears in the stack from 
clicking on the “Add a new operator to the stack” 
button

Here is an example of the Gamma tool being chosen.
Note that it is highlighted with a red bar that indicates
it is active.

After each tool has been adjusted, the user can click on the red bar and it will become gray and in-active. The user can 
click on the “Enable All” or “Disable All” buttons which will toggle all enhancements on and off.

Enable all operators in the stack

Disable all operators in the stack

Remove all operators from the stack
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Grouping Enhancement Tools for future re-use

The user can save the enhancement tools and the adjustments made to those tools so that they can be applied 
to other images. To save a group of enhancements tools that are currently in the stack, simply right-click on the 
image and select the “Send to…” option form the pop-up menu. The “Transfer Image…” window will open. Click 
on the “Grouped Enhancements” button. A pop-up list will appear, and the user should select Save from that list. 
The “Grouped Enhancements Label” window will open where the user can assign a name to the new group of 
enhancements. Then click OK.

When a new image is opened in the Diagnosis View Tab, the user can click on the “Apply Grouped Enhancements” 
button and select the name of the group to apply to the image. The “Apply Grouped Enhancements” button will 
remember the last group that was used and show that one at the top of the list until a different group is selected.

This grouping also applies to Demographic Information Overlays. Add the Demographic information to the stack and 
then right-click on the image. In the “Transfer Image…” window, choose the “Demographic Overlay Template” button. 
Enter a name and click OK.

Diagnosis View Tab Toolbars (Upper)

Save the current image

Drag mouse to 
define region to 
zoom in to

Zoom in

Zoom out

Magnification 
window

Fit image to 
window - (Zoom 
percentage)

Toggle annotations
/demographics on-off

Apply grouped 
enhancement 
to current image

Apply demographic 
data to current image

Add a comment 
to current image

Clear current image
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Diagnosis View Tab Toolbars (Lower)

Lower Left

Lower Right

Histogram

Pseudo - Colors

Threshold

Crop

Gamma

Invert

Mirror Horizontal

Rotate 90° CCW

Rotate 90° CW

Sharpen - Gaussian

USM - Unsharp Mask

Window - Level - Gamma

Histogram Window
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Study View Tab

Once a study of images is captured, they can be viewed in the Study View Tab. If the images were acquired using 
one of the Acquisition Templates, then they can be viewed in a predefined layout that has been designed for that 
template. This will allow the user to see the images as if they were in an image chart. Also, the right-hand toolbar can 
be minimized to allow for maximum image viewing. The user can also select any study for the active patient from the 
Study drop-down list.

An Individual image can be removed from the layout by right-clicking on the image and selecting the “Remove from 
Layout” option in the pop-up menu.
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Study View Tab Toolbar

Add Empty Layout to the Study

Removes the Currently visible layout
from the Study

Reload images to get updates

Expand/Collapse
            Stack

Expand/Collapse
         Filmstrip

Status Window
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Light Box Tab

The Light Box tab was designed to mimic a light box used to view �lm. Any number of images from any patient or 
study can be viewed in this tab. The software will automatically scale and arrange the images, so that they all �t on the 
screen. The Image Transfer System (discussed next) is the easiest way to get images into the light box.

Once images are in the tab, they can be dragged to any position, for an optimum viewing arrangement.

Light Box Tab Tools

Select All

De-select All

Zoom In

Zoom Out

Brightness/Contrast/Gamma
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The Image Transfer System

In order to transfer images from tab to tab, between patients, into other file formats, across the internet and to tother 
locations, the Image Transfer System was created. To send an image to a different location, right-click on the image or 
thumbnail, and select the “Send Image” item from the pop-up menu. This will open the “Transfer Images” window.

The selected image will be shown as well as the options for where that image can be sent. Click on the location to 
which you wish to send the image and it will be sent.
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The same option is available to get images. Simply right-click and select “Get Image”, from the pop-up menu. The 
“Transfer Images” window will open in the “Get Images From” tab. This will show where images can be transfered from 
and thumbnails of the images available in each location.

Click once on each image you want, and it will get a green check mark. Then click on the “Get selected Images” button.
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Import Image… can be used to import an image file.
Import DICOM Dir… can be used to import DICOM 
directory patient information and image files.
Switch Users… allows the user to change the user account 
that is logged in.
Change Password can only be used by the administrator 
user to change user account passwords.
Exit will close the software.

ViewAll Vet File Menu

ViewAll Vet Edit Menu

ViewAll Vet Drivers Menu

ViewAll Vet Tools Menu

Undo/Redo changes made to the image stack.
User Accounts, Provider List and Facility List allows the 
user to edit the information and add new items.
The Layout Editor tool is very useful for changing and 
creating the Acquire Template layouts. 
Please see Appendix A for more details.
Media Recycle Bin allows the user to undelete images or 
completely remove images from the ViewAll Vet database.
Add Species/Breeds allows the user to add to the default 
list of species and breeds that come with ViewAll Vet.
Demographic Data Sets and Grouped Enhancements 
that have been created by a user can be edited.

The Diver Manager is used to select a hardware device to 
capture images with.

Report Generator allows the user to create PDF files of 
images and text for printing through Acrobat Reader. See 
the next section for more details.
Check For Updates launches a web browser and goes to 
the AFP Imaging webpage containing the latest ViewAll Vet 
software version.
Back-up Utility allows the user to select a location to back-
up all necessary files, in case of a Hardware Failure. This tool 
should be used regularly!
Check Database Connection will verify that a network 
database connection is healthy.
Hard-Drive Clean-up will remove deleted image files from 
the hard-drive to free up space for new images.
Replicate All Files is used for Network Mode. It will create 
copies of all Image files locally to improve the image 
loading time.
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ViewAll Vet Tools Menu (Cont’d)

Change Language can be used to toggle between English 
and other languages.
Monitor Calibration can be used to adjust your monitor 
settings for ideal viewing.
Import ProImage Database is for current ProImage 
customers who have upgraded to ViewAll Vet. This will 
import all Patient and image information into ViewAll Vet. 
This tool will create NEW image files in DICOM format in the 
ViewAll Vet database. Please check that you have enough 
Hard-drive space before using this tool. It is strongly 
recommended to contact Tech Support at AFP before 
attempting to use this tool.
DICOM Settings allows the user to edit the information 
needed to configure Send, Receive and Worklist functions 
for multiple servers.
Options This tool contains a number of general settings 
that the user can choose from.

DICOM Configuration Settings Window
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ViewAll Vet Preview Menu

ViewAll Vet Help Menu

Manage tool allows the user to create or delete preview 
windows. As the windows are created, they will be 
appended to the preview menu.
Clear All Windows will clear all images from the active 
preview windows.

Online Help will Launch the default internet provider and 
open the AFP Imaging website and the ViewAll Vet support 
page.
User’s Manual launches the User Manual.
License Registration allows the user to enter the serial 
number that came with the ViewAll Vet CD. Based on this 
number, the software generates a Challenge Code. Both 
numbers must be supplied to AFP Imaging, either online or 
by phone, to receive the activation code that will register 
the software installation.
About tells the user information about the software. 
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Enhancement Tool Descriptions (Cont’d)

Pseudo Color - found in lower-left Acquire Tab Toolbar 

Apply color to a grayscale image, with matching grayscale 
intensities assigned one color.

USM

Unsharp Mask - A technique used to enhance the edges of 
an image. The unsharpen mask tends to show more details in 
areas of an image that are normally more difficult to see.

Window/Level/Gamma

Adjusts window, level and gamma settings in one user 
interface.

After

Before
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Window/Level/Gamma adjustment window
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To create a custom layout, click on the New Layout Button. 

If there is an image file you wish to use as the background to the layout, select File < Import Image and import the 
image into ViewAll Vet, to any tab. Then in the layout editor, click on the Schematic button and select the imported 
image file!

Now add Regions, each region must have a unique name. 
Move the Region marker to the corresponding region in the schematic.

Select Layout Editor from the Edit menu. The following window will open:

Appendix A

Layout Editor
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Now move the View marker to the appropriate location on the schematic and make any adjustments to the 
corresponding square.

Then Enter the sequence number, or Zero for no sequence.

Then Add one grouped enhancement set to the View or select NONE.

Then Associate the View with a Region.

Now add Views. 
Give each View a Label that will be displayed to the user and will be saved in the DICOM tags of the images.
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When done, select a species that the layout should be associated with, select General for all species. Then click Save 
and enter a unique name for your custom Layout.
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To send an image to the report generator, right-click on the image(s) and select Send to…
Click on the Add to Active Report button!

Appendix B

Report Generator

The report generator is the ONLY means for PRINTING in ViewAll Vet.

To create a new report, go to Tools > Report Generator. The following window will open:
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To add text, click on the Add Section Button.
Delete the default text “Enter text here…” and enter the text you want to be displayed.

Now the image will appear in a new section of the report.
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To automatically add information from the database, click on the corresponding Info buttons on right.

When all the information and images have been added, click on the Generate Report button. Then select the location 
and name of the file. 

Acrobat Reader 8.0 will automatically open (if it is installed) with the newly created report document. The user can now 
print this new report!
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Appendix C

Network Setup

ViewAll Vet can be set up to run in two (2) modes: Stand-Alone OR Network.

The mode of operation should be decided at the time of installation.

Stand-Alone mode should be used for any installation that will only use one computer to acquire and view images 
using ViewAll Vet. Simply select the Stand-Alone mode during the InstallShield window as shown below. No additional 
steps are required. 

If a network will be used to send images to a PACS server or via teleradiology utilizing DICOM Send, the Stand-Alone 
mode is still the one of choice

Network mode should be used for installations where several different computers will be used to acquire and view 
images with ViewAll Vet.

To have multiple computers connect to ONE ViewAll Vet database, one installation must HOST the database. The Host 
computer must ALWAYS be on and ViewAll Vet must ALWAYS be running. 

Step One: The first installation should be done on the computer (preferably a server) that will be hosting the Database.  
Choose the “Network Mode and Host the database” option during the InstallShield window as shown below. 

Step Two: All additional computers should be installed as clients, to do that select “Network Mode and connect to 
already hosted database” option during the InstallShield window as shown below.
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In order for all the CLIENT computers to find the HOST, the user may need to enter the computer name of the Host 
computer/server. 

To find the computer name, right-click on My Computer and select Properties from the pop-up menu. Click on the 
Computer Name tab, as shown below. The Full computer name should be entered on the client computers, if ViewAll 
Vet cannot automatically find the Host.
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